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Abbreviations. 
BCIP, 5-Bromo-4-chloro-3-indolyl phosphate disodium salt; 
BOP, (benzotriazol-1-yloxy)tris-(dimethylamino)phosphonium hexafluorophosphate; 
BPB, bromophenol blue; 
CHCA, α-cyano-4-hydroxycinnamic acid; 
6-Cl-HOBt, 6-chloro-1-hydroxy-1H-benzotriazole; 
DCC, dicyclohexylcarbodiimide; 
Dde, 1-(4,4-dimethyl-2,6-dioxacyclohexylidene)ethyl; 
DIC, N,N’-diisopropylcarbodiimide; 
DIEA, diisopropylethylamine; 
Dmab, 
2-{1-[4-(Hydroxymethyl)phenylamino]-3-methylbutylidene}-5,5-dimethyl-1,3-cycloh
exanedione; 
DMAP, dimethylamino-pyridine ; 
DTT, dithiothreitol; 
FPP, farnesyl pyrophosphate; 
HCTU, O-(6-Chloro-1-hydrocibenzotriazol-1-yl)-1,1,3,3-tetramethyluronium 
hexafluorophosphate 
HMPA, 4-hydroxymethyl-phenoxyacetic acid; 
PFTase, protein farnesyltransferase; 
SP-AP, streptavidin alkaline phosphatase; 
TBTA, tris[(1-benzyl-1H-1,2,3-triazol-4-yl)methyl]amine; 
TCEP, tris(2-carboxyethyl)phosphine hydrochloride, 
TFA, trifluoroacetic acid; 
Tris, tris(hydroxymethyl)aminomethane; 
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General:  
All synthetic reactions were carried out at 25 C and stirred magnetically unless 
otherwise noted. TLC was performed on precoated (250 mm) silica gel 60 F-254 
plates (Merck). Plates were visualized by staining with KMnO4 or hand-held UV 
lamp.  Flash chromatography silica gel (60–200 mesh, 75–250 µm) was obtained 
from Mallinckrodt Inc. Deuterated NMR solvents were purchased from Cambridge 
Isotope Laboratories, Inc. Biotin-azide was purchased from ChemPep. All amino 
acids and peptide coupling reagents were purchased from NovaBiochem. Other 
general reagents, including salts and reagents, were purchased from Sigma-Aldrich. 
1H NMR spectra were obtained at 300 MHz; 31P NMR spectra were obtained at 121 
MHz. All NMR spectra were acquired on Varian instruments at 25°C. Chemical shifts 
are reported in ppm and J values are in Hz. SPOT synthesizer is ResPep SL obtained 
from INTAVIS Bioanalytical Instruments. Fluorescence assay data were obtained by 
using a Varian Cary Eclipse Fluorescence Spectrophotometer. Analytical HPLC was 
performed on a Beckman model 125/166 instrument, equipped with a diode array UV 
detector, ABI Analytical Spectroflow 980 fluorescence detector, and a Varian C18 
column (Microsorb-MV, 5 µm, 4.6x250 mm). Preparative HPLC separations were 
performed by using a Beckman model 127/166 instrument, equipped with a UV 
detector and a Phenomenex C18 column (Luna, 10 µm, 10x250 mm). Fluorescence 
scanning was done by Storm 840 Phosphor-Chemifluorescence Workstation 
(excitation 450 nm & emission 540-560 nm). MS spectra for small molecules were 
obtained on a Bruker BioTOF II instrument. MS spectra for peptide libraries were 
obtained on an AB Sciex 4800 MALD TOF/TOF or Bruker Biflex III instrument. 
Yeast PFTase1, Ds-GCVIA1 and OPP-Far-alkyne2 were prepared as previously 
described. OPP-Ger-NBD was prepared using a reported reaction procedure.3 

 
Analogues used to screen peptide libraries for PFTase activity. 
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Scheme S1. Synthesis of the photocleavable linker used for library synthesis.  Reagents and 

conditions: (i) Br2, 1,4-dioxane, room temp, 3 h; (ii) NaBH4, H2O/1,4-dioxane, 0 oC to RT, 1.5 h, 

then NaOH(aq), RT, 15 min; (iii) NaN3, NH4Cl, EtOH/H2O, reflux, 12 h; (iv) PPh3, THF, 0 oC to 

RT, 2 h, then H2O, RT, 12 h; (v) Dde-OH, CH2Cl2, RT, 18 h; (vi) p-nitrophenyl chloroformate, 

pyridine, CH2Cl2, RT, 350 min. 
 
O-nitrophenacyl bromide (S1-2) 
Steps (i) and (ii) were performed according to a previously published procedure.4 A 
solution of Br2 (4.5 mL, 87.6 mmol) in dioxane (80 mL) was added dropwise over a 
30 min period to a solution of o-nitroacetophenone (S1-1) (14.44 g, 87.4 mmol) in 
dioxane (40 mL). After the addition was completed, the mixture was stirred for 2.5 h. 
The solvent and HBr formed were removed by rotary evaporation followed by the 
addition of H2O (60 mL). The solution was extracted with Et2O (3×50 mL) and the 
combined organic layers were dried with MgSO4 and concentrated by rotary 
evaporation to yield S1-2 as a brown oil. Crude compound (2) was used without 
further purification. 1H NMR (CDCl3): δ 4.30 (s, 2H), 7.51 (dd, J = 1.5, 7.2, 1H), 7.68 
(ddd, J = 1.8, 7.8, 8.4, 1H), 7.80 (ddd, J = 1.2, 7.5, 7.5 1H), 8.24 (dd, J = 1.2, 8.4, 
1H). 
 
O-nitroepoxystyrene (S1-3) 
A suspension composed of NaBH4 (3.31 g, 87.4 mmol) and H2O (30 mL) was added 
dropwise to a solution of o-nitrophenacyl bromide (S1-2) (prepared in previous step) 
in dioxane (30 mL) over a 40 min period at 0 °C with stirring. The mixture was stirred 
at 0 oC for 40 min and then at RT for 70 min. An aqueous solution of NaOH (4.14 g / 
30 mL) was added to the mixture. The mixture was stirred at RT for 15 min. H2O (40 
mL) was then added and the solution was extracted with Et2O (3×50 mL). The 
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combined organic layers were dried with MgSO4 and concentrated by rotary 
evaporation. The resulting oil was purified by silica gel column chromatography (1:60 
Et2O/hexanes containing 2% Et3N) to yield S1-3 as a yellow solid (8.63 g, 59.8% 
yield). 1H NMR (CDCl3): δ 2.68 (dd, J = 2.7, 5.4, 1H), 3.30 (dd, J = 4.5, 5.7, 1H), 
4.49 (dd, J = 2.7, 4.5, 1H), 7.48 (ddd, J = 1.8, 6.9, 6.9, 1H), 7.65 (m, 2H), 8.16 (dd, J 
= 1.2, 8.4, 1H). 
 
2-azido-1-(2-nitrophenyl)ethanol (S1-4) 
To a mixture of compound (S1-3) (8.63 g, 52.3 mmol) in EtOH (70 mL) was added 
NaN3 (4.08 g, 62.8 mmol), NH4Cl (2.87 g, 53.7 mmol) and then water (70 mL). The 
mixture was stirred at reflux for 16 h. EtOH was removed by rotary evaporation. H2O 
(40 mL) was added and the solution was extracted with Et2O (3×50 mL). The 
combined organic layers were dried with MgSO4 and concentrated by rotary 
evaporation. The resulting oil was purified by silica gel column chromatography (1:3 
Et2O/hexanes) to yield S1-4 as a yellow oil (4.41 g, 40.5% yield). 1H NMR (CDCl3): 
δ 3.46 (dd, J = 7.5, 12.3, 1H), 3.76 (dd, J = 3.0, 12.3, 1H), 5.51 (dd, J = 3.3, 7.2, 1H), 
7.50 (ddd, J = 1.5, 8.4, 8.4, 1H), 7.71 (ddd, J = 1.2, 7.5, 7.5, 1H), 7.92 (dd, J = 1.5, 
7.8, 1H), 8.02 (dd, J = 1.2, 8.4, 1H). 
 
2-amino-1-(2-nitrophenyl)ethanol (S1-5) 
Compound S1-4 (4.41 g, 21.2 mmol) was dissolved in dry THF (35 mL). The mixture 
was placed under an N2 (g) atmosphere and cooled to 0 oC. PPh3 (5.85 g, 22.3 mmol) 
was added to this mixture, stirred at 0 oC for 10 min and then RT for 110 min. H2O (3 
mL) was added to this mixture which was then stirred at RT for 16 h. Et2O (50 mL) 
was added and the solution was extracted with 1M HCl (2×35 mL). The aqueous 
layers were combined, adjusted to a basic pH with NaOH(s) and extracted with Et2O 
(3×40 mL). The combined organic layers were dried with MgSO4 and concentrated by 
rotary evaporation to yield compound S1-5 as a yellow solid that was used without 
further purification. 1H NMR (d6-acetone): δ3.79 (dd, J = 7.2, 12.3, 1H), 5.29 (dd, J = 
5.7, 6.6, 1H), 7.54 (ddd, J = 1.5, 7.8, 8.7, 1H), 7.72 (ddd, J = 1.2, 7.2, 8.7, 1H), 7.89 
(dd, J = 1.2, 7.8, 1H), 8.02 (dd, J = 1.2, 8.1, 1H). 
 
2-(1-(2-hydroxy-2-(2-nitrophenyl)ethylamino)ethylidene)-5,5- 
dimethylcyclohexane-1,3-dione (S1-6) 
Preparation of Dde-OH: Dimedone (5.0 g, 0.0357 mol) was dissolved in DMF (75 mL) 
with HOAc (2.0 mL, 34.9 mmol), DCC (7.38 g, 35.8 mol), and DMAP (4.36 g, 35.7 
mmol) and allowed to react for 16 h. Precipitating dicyclohexylurea (DCU) was 
removed by filtration, and the solvent was evaporated in vacuo. After dissolution in 
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EtOAc (50 mL) and washed with 1M HCl (2×50 mL) and subsequently with H2O 
(2×50 mL), the organic phase was dried over MgSO4, filtered and concentrated to 
give a yellowish liquid that slowly solidified upon standing. 1H NMR (CDCl3): δ 1.08 
(s, 6H), 2.36 (s, 2H), 2.53 (s, 2H), 2.61 (s, 3H). ESI-MS [M-H+]: m/z calc. for 
C10H13O3

-: 181.0870; found:181.0852. 
Protection with Dde-OH: Compound S1-5 (1.48 g, 8.15 mmol) was stirred with 
Dde-OH (1.45 g, 7.96 mmol) in 20 mL CH2Cl2 at RT for 16 h. Some CH2Cl2 was 
removed by rotary evaporation and the resulting mixture was purified by silica gel 
column chromatography (3:1 Et2O/hexanes) to yield S1-6 as a yellow solid (2.06 g, 
73.1 %). 1H NMR (CDCl3): δ 0.97 (s, 6H), 2.27 (s, 4H), 2.53 (s, 3H), 3.98 (m, 2H), 
5.55 (dd, J = 3.3, 7.5, 1H), 7.54 (ddd, J = 7.5, 7.5, 1H), 7.72 (dd, J = 7.8, 7.8, 1H), 
8.02 (m, 2H). ESI-MS [M+Na+]: m/z calc. for C18H22N2O5Na+: 369.1421; found: 
369.1480. 
 
2-(1-(4,4-dimethyl-2,6-dioxocyclohexylidene)ethylamino)-1- 
(2-nitrophenyl)ethyl 4-nitrophenyl carbonate (S1-7) 
To a solution of compound S1-6 (0.454 g, 1.31 mol) in CH2Cl2 (5 ml) was added 
4-nitrophenyl chloroformate (0.394 g, 1.95 mmol) and pyridine (0.19 ml, 2.35 mmol). 
The mixture was stirred at room temperature for 350 min. Some CH2Cl2 was removed 
by rotary evaporation and the resulting mixture was purified by silica gel column 
chromatography (3:1 Et2O/hexanes) to yield S1-7 as a white solid (0.487 g, 72.7 %). 
1H NMR (CDCl3): δ 1.047 (s, 6H), 2.36 (s, 2H), 2.43 (s, 2H) 2.57 (s, 3H), 3.97 (dd, J 
= 5.7, 14.4, 1H), 4.22 (dd, J = 3.3, 9.6, 1H), 6.50 (d, J = 4.2, 1H), 7.38 (d, J = 9.6, 2H), 
7.61 (dd, J = 8.1, 8.1, 1H), 7.88 (m, 2H), 8.14 (d, J = 8.1, 1H), 8.25 (d, J = 7.8, 2H). 
ESI-MS [M+H+]: m/z calc. for C25H26N3O9

+: 512.1664; found: .512.1591. 
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Scheme S2. Synthesis of inverted peptides. Reagents and conditions: (i) standard DIC coupling 
(2×), then, capping, then 20% piperidine, then BPB staining; (ii) standard DIC coupling (2×); (iii) 

0.5 M Fmoc-Aa and 0.5 M 6-Cl-HOBt in DMF/CH2Cl2, 0.5 M DIC in CH2Cl2, 0.2 M DMAP in 

CH2Cl2, (6-8×), then, capping, then 20% piperidine, then BPB staining; (iv) standard DIC 

coupling (2×), then, capping, then 20% piperidine, then BPB staining; (v) 0.5 M photocleavable 

linker, 0.5 M Et3N in DMF (3-4×); (vi) 2% NH2NH2; (vii) 0.05 M BOP, 0.05 M 6-Cl-HOBt and 

0.1 M DIEA in DMF (2×); (viii) modified reagent K. 

 
Amino acid residues used in the library synthesis 
Abbreviation Chemical name Abbreviation Chemical name 
B Fmoc-β-Ala-OH K Fmoc-Lys(Boc)-OH 
L Fmoc-Leu-OH H Fmoc-His(Trt)-OH 
R Fmoc-Arg(Pbf)-OH P Fmoc-Pro-OH 
A Fmoc-Ala-OH F Fmoc-Phe-OH 
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G Fmoc-Gly-OH Y Fmoc-Tyr(tBu)-OH 
C Fmoc-Cys(Trt)-OH W Fmoc-Trp(Boc)-OH 
V Fmoc-Val-OH M Fmoc-Met-OH 
I Fmoc-Ile-OH S Fmoc-Ser(tBu)-OH 
Q Fmoc-Gln(Trt)-OH T Fmoc-Thr(tBu)-OH 
D Fmoc-Asp(OtBu)-OH Fmoc-Glu(OtBu)-OH 
N Fmoc-Asn(Trt)-OH 

E 
Fmoc-Glu-ODmab 
(For cyclization) 

 
Synthesis of inverted peptides 
Manual synthesis: 
The inverted peptides were synthesized on amino-functionalized cellulose membranes 
(0.40 mmol/g). All of the manipulations were performed at RT unless otherwise noted. 
The peptides were synthesized by spotting 1 µL of 0.5 M Fmoc-amino acid and 1 µL 
of 0.5 M DIC in DMF. The coupling reaction was typically allowed to proceed for 30 
min twice. The membrane was incubated with 2% (v/v) Ac2O in DMF (capping 
solution A) for 5 min, followed by 2% (v/v) acetic anhydride, 2% (v/v) DIEA in DMF 
(capping solution B) for 15 min without shaking. The membrane was then washed 
with DMF (3×). The Fmoc groups were removed by treatment twice with 20% 
piperidine in DMF (5+5 min) followed by washing of the membrane with DMF (4×) 
and MeOH (2×). The membrane was then stained with BPB in MeOH (40 mg/L) to 
visualize the spot locations. The membrane was then washed with MeOH (4×) and 
Et2O (2×).  
Next, HMPA was coupled to the growing peptide chain using the above procedure. 
The membrane was washed with MeOH (4×), diethyl ether (2×) without capping.  
Next, esterification of the links which will be the C-terminal residue in the final 
product was accomplished by spotting sequentially 1 µL of 0.5 M Fmoc-amino acid, 
6-Cl-HOBt in DMF/CH2Cl2 (v/v = 50:50), 1 µL of 0.5 M DIC in CH2Cl2 and 1 µL of 
0.2 M DMAP in CH2Cl2. Each coupling reaction was typically allowed to proceed for 
30 min. The process was repeated for six to eight times. The membrane was then 
incubated with capping solution A for 5 min followed by capping solution B for 15 
min without shaking. The membrane was washed with DMF (3×) and the Fmoc group 
was removed by treatment twice with 20% piperidine in DMF (5+5 min). The 
membrane was washed with DMF (4×), MeOH (2×). The membrane was stained with 
BPB in MeOH (40 mg/L) to indicate spot locations. The membrane was washed with 
MeOH (4×) followed by Et2O (2×). 
To add the photocleavable linker, 1 µL of 0.5 M photocleavable linker solution and 1 
µL of 0.5 M Et3N in DMF were spotted onto the membrane. The coupling reaction 
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was typically repeated three to four times with each time to proceed for 30 min.  
Next, the Dmab and Dde protecting groups were removed by treatment with 2% 
hydrazine solution in DMF (3×10 min) followed by washing with DMF and MeOH. 
For peptide cyclization, a solution of (BOP)/6-Cl-HOBt/DIEA (0.05 M, 0.05 M, 0.1 
M respectively) in DMF was mixed with the membrane. This reaction was performed 
twice, the first time for 2 h and the second time for 16 h. The membrane was washed 
with DMF (3×), MeOH (2×) and Et2O (2×).  
The membrane was treated with a modified reagent K (6.5% phenol, 5% H2O, 5% 
thioanisole, 2.5% ethanedithiol, 1% anisole, and 1% triisopropylsilane in TFA) for 2 h 
for ester cleavage (ring opening) and side-chain deprotection. 
SPOT Synthesizer: 
The peptides were synthesized by ResPep SL SPOT-robot (INTAVIS Bioanalytical 
Instruments). The synthesis started with spot definition by a standard protocol 
followed by the coupling of a solution of 0.11 µL of Fmoc-amino acid (0.5 M), 0.055 
µL of DIC (1.1 M) and 0.055 µL of 6-Cl-HOBt (1.2 M) in DMF (double coupling, 10 
and 15 min reaction each). The membrane was acetylated with acetic anhydride in 
DMF (2%), washed with DMF (3×) and EtOH (3×) and finally air-dried. Fmoc was 
removed by 20% piperidine in DMF (3×). After HMPA was coupled to the growing 
peptide chain using the above procedure, the membrane was washed with DMF (3×), 
EtOH (3×) without capping. 
For ester-bond formation (step iii), 0.22 µL of solution Fmoc-amino acid (0.4M) 
activated with 1,1’-carbonyldiimidazole (CDI, 3 equiv.) in DMF were spotted on the 
membrane (4× coupling, 15 min reaction time each). 
To add the photocleavable linker, 0.22 µL of 0.5 M photocleavable linker solution 
mixed with Et3N (2 equiv.) in DMF were spotted onto the membrane (4× coupling, 15 
min reaction time each). 
The procedure of peptide cyclization, side-chain cleavage and other steps was the 
same as manual synthesis. 
 
MALDI MS analysis of peptides obtained via SPOT synthesis before and after 
enzymatic prenylation 
Although it has been reported that treatment of prenylated peptides with CNBr, does 
not cause loss of the prenyl group,8 we found substantial cleavage occurred. Thus 
CNBr could not be used to cleave the peptides from the resin and our strategy 
switched to a photocleavable linker. Accordingly, each spot membrane was incubated 
with 500 µL CH3CN/H2O (v/v = 5/95) in a microcentrifuge tube. Peptide release was 
accomplished by shining UV light (λ = 365 nm) on the side of the tube for 1 h. After 
photolysis, the solvent was transferred to a new microcentrifuge tube. The membrane 
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was washed with 500 µL CH3CN and then 500 µL MeOH. The combined solution 
was concentrated in vacuo. The resulting residue was dissolved in 70 µL CH3CN/H2O 
(v/v = 5/95) with 0.1% TFA. In a typical MALDI experiment, 0.7 µL of peptide 
solution was mixed with 0.7 µL CHCA matrix (10 mg/mL; CH3CN/H2O (v/v = 50/50) 
with 0.1% TFA) on the MALDI target and air dried. 
 
Screening for PFTase specificity with OPP-Far-alkyne 
Spots from manual synthesis: 
Spots from the membranes produced above were excised and incubated with 155 mM 
DTT for 1 h and then washed with H2O (1×). Typical conditions for PFTase reactions 
were 5.1 mM DTT, 5 mM MgCl2, 50 µM ZnCl2, 200 mM Tris (pH=7.5), 1 mg/mL 
BSA, 260 µM OPP-Far-alkyne, 0.09 mg/mL PFTase. The membranes were incubated 
in the solution for 30 min before adding OPP-Far-allkyne and PFTase. The enzymatic 
reactions were typically allowed to proceed for 4 h followed by washing with 25 mM 
NH4HCO3(aq) (4×), CH3CN (4×) after which the membranes were transferred to new 
1.5 mL microcentrifuge tubes. 
Typical conditions for click reactions were 0.1 mM biotin-azide, 1 mM TCEP, 0.2 
mM TBTA, 1 mM CuSO4 in PBS buffer 1 (137 mM NaCl, 2.7 mM KCl, 10 mM 
Na2HPO4, 2mM KH2PO4, pH=7.4). The reaction was typically allowed to proceed for 
16 h. After the reactions, the membranes were washed with H2O (4×), DMF (4×) and 
placed in new tubes. 
The membranes were incubated with 5 % milk in PBS buffer 2 (100 mM KH2PO4, 
500 mM NaCl, pH=6.5) for 1 h and then incubated with SP-AP in 5% milk PBS 
buffer 2 (v/v = 1/800) for 30 min. After the reactions, the membranes were washed 
with PBS buffer 2 (7×) and placed in new tubes. Upon addition of 750 µL of buffer E 
(5 mM MgCl2, 20 µM ZnCl2, 100 mM NaCl, 30 mM Tris, pH=8.5) and 50 µL of 5 
mg/mL BCIP solution, turquoise color developed on positive spots after 1 h. The 
staining was terminated by adding 200 uL of 10 M HCl. 
Spots from SPOT synthesizer: 
The whole membrane was incubated with 155 mM DTT for 1 h and then washed with 
H2O (1×). Typical conditions for PFTase reactions were 5.1 mM DTT, 5 mM MgCl2, 
50 µM ZnCl2, 100 mM Tris (pH=7.5), 1 mg/mL BSA, ~100 µM OPP-Far-alkyne, 
0.045 mg/mL PFTase. The enzymatic reactions were typically allowed to proceed for 
4.5 h followed by washing with 25 mM NH4HCO3(aq) (3×), CH3CN (3×), and H2O 
(3×). 
Typical conditions for click reactions were 0.1 mM biotin-azide, 1 mM TCEP, 0.2 
mM TBTA, 1 mM CuSO4 in PBS buffer 1. The reaction was typically allowed to 
proceed for 16 h. After the reactions, the membranes were washed with H2O (3×), 
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DMF (3×), and H2O (3×). 
The membranes were incubated with 5 % milk in PBS buffer 2 for 1 h and then 
incubated with SP-AP in 5% milk PBS buffer 2 (v/v = 1/800) for 30 min. After the 
reactions, the membranes were washed with H2O (9×). Upon addition of BCIP 
solution in buffer E (0.313 mg/mL), turquoise color developed on positive spots after 
1.5 h. The staining was terminated by washing with H2O (2×) and CH3CN (1×). 
 
The quantification of color intensity was performed using Image J software. The 
membrane was scanned and saved. The file was opened by Image J. Under 
Image>Type, 8-bit was selected to convert the image to grayscale. Under the menu 
Process>Subtract Background, the rolling ball radius was set to 50. Under 
Analyze>Set Measurements, the Area, Mean Gray Value, and Integrated Density 
were selected. Under Analyze>Set Scale, “pixels” in the box next to Unit of length 
were selected. Under Edit>Invert, the colors on the image were inverted, a line was 
drawn around the image boundary and the measurement of the selected are was then 
performed using the “m” key. 
 
Kinetic analysis of individual peptides for substrate verification 
The rates of farnesylation of individual purified peptides by PFTase were determined 
using the time-dependent increase in fluorescence (λex 340 nm, λem 510 nm) upon 
prenylation of a dansylated form of the peptide. Assays were performed with 2.4 µM 
dansylated peptide, 70 nM PFTase, 10 µM OPP-Far-alkyne, 200 mM Tris, pH 7.5, 5 
mM DTT, 5 mM MgCl2, 50 µM ZnCl2, and 0.040 % (w/v) n-dodecyl-ß-D-maltoside 
at 25 °C. Peptides were incubated in reaction buffer for 5 min prior to initiation by the 
addition of PFTase. Fluorescence was measured as a function of time to define both 
the initial linear velocity and the reaction end point. The total fluorescence change 
observed upon reaction completion was divided by the initial concentration of the 
peptide substrate in a given reaction to yield a conversion from fluorescence units to 
product concentration (Ampconv). The linear initial rate, V, in fluorescence intensity 
per minute, was then converted to a velocity (µM product produced per minute) by 
dividing V with Ampconv. 
 
Evaluation of Rce1 activity for RAGC(farnesyl)VIA on CPG beads 
CPG beads with a large pore size (1000 Å) were functionalized with the peptide 
RAGCVIA as described above. 0.16 g of the resulting CPG beads (~11.7 µmol 
peptides) were incubated with 4 mL of DTT (155 mM) for at least 1 h. After 
removing the solvent, those CPG beads were washed with DMF (9×). To prepare 
farnesylation solution, Zn(OAc)2．2H2O ( 12.8 mg, 58.3 µmol) and farnesyl bromide 
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(12.7 µL, 46.8 µmol) were dissolved in a mixture of 2 mL DMF, 1 mL 1-BuOH and 1 
mL 0.1% TFA. CPG beads were mixed with farnesylation solution for 3 h. After 
removing the solvent, the CPG beads were washed with DMF (3×) and H2O (3×). 
For the Rce1 proteolysis experiment, the assay involved mixing of CPG beads with 
yeast membranes enriched for the Rce1 protease.5 Membranes used as the source of 
activity were stored as 1 mg/mL stocks. CPG beads (~ 1-2 mg) were incubated with a 
mixture of 500 µL assay buffer (100 mM HEPES, pH 7.5, 5 mM MgCl2) and 50 µL of 
BSA (10 mg/mL) for at least 1 h. 50 µL of the stock Rce1 membranes were added to 
the solution and the reaction tube was gently shaken for 16 h. After removing the 
solvent, the CPG beads were washed with H2O (2×), CH3CN (2×) and H2O (2×). For 
peptide release and MALDI analysis, the procedure described above uder MALDI 
MS analysis of peptides obtained via SPOT synthesis was employed. 
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Figure S1. MALDI analysis of peptides produced by SPOT synthesis performed to 
verify the production of the desired product. The photocleavable moiety shown in Fig. 
3B (main text) was used as the linker. The membranes were treated with UV light 
(365 nm) in CH3CN/H2O (v/v = 5/95). The resins were washed with CH3CN and 
MeOH. The combined solvents were removed in vacuo. The peptides (RAGCVIX) 
were re-dissolved in CH3CN/H2O (v/v = 5/95) with 0.1% TFA.  
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Figure S2. MALDI analysis of peptides produced by SPOT synthesis after enzymatic 
farnesylation performed to confirm successful enzymatic processing. The 
photocleavable moiety shown in Fig. 3B (main text) was used as the linker. After 
enzymatic reaction, the membranes were treated with UV light (365 nm) in 
CH3CN/H2O (v/v = 5/95) to release the peptides. The membranes were washed with 
CH3CN and MeOH and the combined washes were evaporated in vacuo. The peptides 
(RAGCVIX) were re-dissolved in CH3CN/H2O (v/v = 5/95) with 0.1% TFA. 
 

 
Figure S3. MS intensity ratio of prenylated peptides versus unprenylated peptides 
from Figure S4 performed to determine the extent of enzymatic prenylation of 
peptides prepared via SPOT synthesis. 



 24 

 

 

 
Figure S4. Screening of enzymatic prenylation of an RAGCVIX library. Each SPOT  
membrane was prenylated with OPP-Far-alkyne by PFTase, clicked with biotin-azide 
and then visualized by SP-AP in BCIP solution.  Membranes from three separate 
library syntheses and screenings are shown. 
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Fig. S5. Evaluation of the extent of farnesylation of a RAGCVIX library of peptides. 
After synthesis, the peptides were subjected to enzymatic prenylation with an 
alkyne-containing analogue of FPP followed by click reaction with biotin-azide and 
subsequent reaction with streptavidin-AP using a chromogenic substrate. Color 
intensity was quantified by Image J software. The library was synthesized and 
screened three times and the average color intensities from the three trials are plotted 
here along with the SD depicted by the error bars. For comparison, the intensity was 
normalized relative to that observed with Gln at the X position.  
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Figure S6. Screening of enzymatic prenylation of an RAGCVa2X library. Each 
membrane was prenylated with OPP-Far-alkyne by PFTase, clicked with biotin-azide 
and then visualized by SP-AP in BCIP solution. Screenings from two separate 
membranes are shown. 
Spot identity: 
1-20: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)E 
21-40: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)D 
41-60: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)N 
61-80: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)R 
81-100: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)K 
101-120: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)H 
121-140: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)A 
141-160: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)V 
161-180: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)I 
181-200: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)L 
201-220: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)F 
221-240: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)W 
241-260: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)G 
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261-280: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)C 
281-300: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)M 
301-320: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)S 
321-340: CV(A,R,N,D,C,Q,E,G,H,I,L,K,M,F,P,S,T,W,Y,V)T 
361-377: SVI(E,D,N,R,K,H,A,V,I,L,F,W,G,C,M,S,T) 
 

  
Figure S7. Analysis of preferred residues at the X position and a2 position for a 
Ca1a2X-box obtained from screening of a 340-member library of peptides.  Left (A): 
Preferences for the X position.  Right (B): Preferences for the a2 position.  These 
preferences were determined by summing the intensities obtained for a single residue 
at the X or a2 position across all possible combinations at the adjacent position.  For 
example, to calculate the preference for E at the X position, all intensity values 
present in the “E” row in Fig. 3 were summed (7+2+3+2+22 etc).  To calculate the 
preference for A at the a2 position, all intensity values present in the “A” column in 
Fig. 3 were summed (7+3+57+3+11 etc).  
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Sequence Screening 

value 
PrePS7 Kinetic 

assay6 
Sequence Screening 

value 
PrePS7 Kinetic 

assay6 
CVAM 95 -3.2 (-) NA CVFA 66 -3.6 (-) NA 
CVAS 79 -3.6 (-) NA CVPM 67 -0.4 (+) NA 
CVNM 95 -3.3 (-) NA CVPS 76 -0.7 (+) NA 
CVNS 80 -3.6 (-) NA CVSN 70 -4.0 (-) NA 
CVCN 80 -3.6 (-) NA CVSH 70 -2.0 (+) NA 
CVCA 74 -0.9 (+) Sub CVSA 77 -1.3 (+) NA 
CVCM 77 -0.5 (+) NA CVSF 70 -1.6 (+) NA 
CVCS 83 -0.9 (+) NA CVSM 94 -0.9 (+) NA 
CVQM 91 0.4 (++) MTO CVSS 87 -1.3 (+) STO 
CVQS 89 0.2 (++) NA CVTN 104 -2.7 (-) NA 
CVGM 68 -3.2 (-) NA CVTH 76 -0.7 (+) NA 
CVHA 68 -3.7 (-) NA CVTA 104 -0.0 (+) Sub 
CVHM 78 -3.7 (-) NA CVTV 79 -0.7 (+) NA 
CVHS 73 -3.7 (-) MTO CVTF 79 -0.4 (+) NA 
CVIE 82 -1.3 (+) Sub CVTC 70 0.2 (++) NA 
CVID 77 -1.9 (+) NA CVTM 103 0.4 (++) NA 
CVIN 100 -1.6 (+) Sub CVTS 99 0.0 (++) NA 
CVIA 81 1.1 (++) Sub CVTT 70 -0.7 (+) MTO 
CVIM 81 1.4 (++) Sub CVYM 81 -4.1 (-) NA 
CVIS 84 1.1 (++) Sub CVVE 74 -1.7 (+) NA 
CVIT 73 0.5 (++) Sub CVVN 73 -2.1 (-) MTO 
CVLN 84 -2.4 (-) NA CVVH 68 -0.2 (+) NA 
CVLA 78 0.3 (++) Sub, 

MTO 
CVVA 78 0.6 (++) Sub 

CVLM 78 0.6 (++) NA CVVM 99 0.9 (++) Sub 
CVLS 79 0.3 (++) Sub CVVS 89 0.6 (++) NA 
CVMM 71 -0.3 (+) NA CVVT 68 -0.1 (+) MTO 
CVFN 70 -6.5 (--) NA      

Fig. S8. Comparison of screening results described here with Prenylation Prediction 
Suite PrenPS (http://mendel.imp.ac.at/PrePS/index.html)7 and previously reported 
kintetic data obtained via in vitro enzyme assays.6 Only peptides sequences giving 
high intensity signals (intensities above 66% in Fig. 3, highlighted in red) from the 
screening are included in this table. For PrenPS predictions, an upstream sequence of 
GGLLBBQFRAGCa1a2X was employed. For the previously reported kinetic assay 
data, NA indicates sequences not measured, Sub indicates Ca1a2X sequences from 
known farnesylated proteins, MTO indicates sequences that exhibit multiple-turnover 
activity and STO indicates sequences that exhibit single-turnover activity. 
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Figure S9. HPLC analysis of individually synthesized dansylated peptide used for 
kinetic experiments. Solvent A was H2O with 0.1% TFA. Solvent B was CH3CN with 
0.1% TFA. The gradient was from 0% to 100% Solvent B from 5 min to 55 min. 
Absorbance wavelength was 340 nm. The purifity of all peptides was above 90 % as 
determined from peak integration. 
 

Ds-GCVIN DsGCVIA Ds-GCVIT 
3.60 ± 0.25 2.39 ± 0.25 2.28 ± 0.10 
Ds-GCVID Ds-GCVIK Ds-GCVLL 

 
v 

 (uM/min) 
0.033 ± 0.003 0.048 ± 0.009 0.032 ± 0.004 

Table S1 Evaluation of Ds-GCaaX peptides versus yFTase. Assays were performed 
using 2.4 µM dansylated peptide, 70 nM FTase, 10 µM OPP-Far-alkyne, in 200 mM 
Tris, pH 7.5, 5 mM DTT, 5 mM MgCl2, 50 µM ZnCl2, and 0.040 % (w/v) 
n-dodecyl-ß-D-maltoside.
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Figure S10. MALDI analysis of RAGC(farnesyl)VIA with Rce1 treatment to confirm 
successful enzymatic proteolysis on solid surface. (A) RAGC(farnesyl)VIA released 
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from CPG before Rce1 reaction. (B) Peptides released from CPG after Rce1 reaction 
showing the presence of both full length RAGC(farnesyl)VIA and the cleavage 
product RAGC(farnesyl). (C) Analysis of RAGC(farnesyl)VIA after exposure to yeast 
membranes produced from a deletion strain lacking Rce1 showing very low intensity 
of cleaved product. 
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